After-School Programs in Saint Paul: Availability & Access

Identifying the spatial relationships between the locations of after-school programs and student demographics in Saint Paul, MN

May 3rd, 2007
Macalester College
Department of Geography
Saint Paul, MN
<table>
<thead>
<tr>
<th>CONTENTS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Executive Summary</td>
<td>3</td>
</tr>
<tr>
<td>List of Maps</td>
<td>5</td>
</tr>
<tr>
<td>Acknowledgements</td>
<td>7</td>
</tr>
<tr>
<td>Introduction and Objectives</td>
<td>8</td>
</tr>
<tr>
<td>Definitions</td>
<td>9</td>
</tr>
<tr>
<td>Student Characteristics</td>
<td>11</td>
</tr>
<tr>
<td>- Introduction</td>
<td></td>
</tr>
<tr>
<td>- Methodology</td>
<td></td>
</tr>
<tr>
<td>- Map Analysis and Evaluation</td>
<td></td>
</tr>
<tr>
<td>- Summary</td>
<td></td>
</tr>
<tr>
<td>After-School Programs</td>
<td>29</td>
</tr>
<tr>
<td>- Introduction</td>
<td></td>
</tr>
<tr>
<td>- Methodology</td>
<td></td>
</tr>
<tr>
<td>- Map Analysis and Evaluation</td>
<td></td>
</tr>
<tr>
<td>- Summary</td>
<td></td>
</tr>
</tbody>
</table>
### Access to After-School Programs

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>59</td>
</tr>
<tr>
<td>Literature Review</td>
<td></td>
</tr>
<tr>
<td>SATS Method</td>
<td></td>
</tr>
<tr>
<td>- Methods and Limitations</td>
<td></td>
</tr>
<tr>
<td>- Map Analysis and Evaluation</td>
<td></td>
</tr>
<tr>
<td>Composite Method</td>
<td></td>
</tr>
<tr>
<td>- Methods and Limitations</td>
<td></td>
</tr>
<tr>
<td>- Map Analysis and Evaluation</td>
<td></td>
</tr>
<tr>
<td>Summary</td>
<td></td>
</tr>
</tbody>
</table>

### Recommendations

<table>
<thead>
<tr>
<th></th>
<th>83</th>
</tr>
</thead>
</table>

### References

<table>
<thead>
<tr>
<th></th>
<th>87</th>
</tr>
</thead>
</table>

### Technical Appendices

<table>
<thead>
<tr>
<th></th>
<th>88</th>
</tr>
</thead>
</table>
EXECUTIVE SUMMARY

Introduction and Objectives

The report that follows is the result of work done between February and May of 2007 by the Advanced Geographic Information Systems class at Macalester College upon the request of the Saint Paul Mayor’s Office. Assisting the city’s Second Shift Initiative, our task was to identify the gaps in after-school opportunities by mapping public school students, current programs, and measurements of access across the city.

This project was divided into three sections: information about students, information about after-school programs, and student access to after-school programs. Our objectives were to identify and map after-school programs and map the relationship between program and student location, taking into account the types of programs offered and the demographics of the student population.

Student Characteristics

Analysis of the student data reveals the relationships between the characteristics of the students living in the various block groups of Saint Paul. Clustering analysis of the characteristics indicates that the students are statistically significantly clustered. By comparing the maps of the different student characteristics, it is evident that some demographic characteristics are related.

Neighborhoods with a high percentage of non-white student populations, such as the “East Side”, also show a low percentage of English speaking students. In addition, the areas with large non-white student populations spatially correlate with areas of high percentage of students that qualify for subsidized lunches and often with areas where students perform below average in standardized scores. Examples of neighborhoods that show these characteristics include the “Thomas Dale” and the “West Side” neighborhoods.

After-School Programs

Analysis of the location of after-school programs in Saint Paul reveals that programs are clustered across Saint Paul. In other words, areas with after-school programs generally have multiple programs and other areas are likely to have few or no programs. Additionally, the 10 percent of block groups with the highest student populations have 28 percent of the student population of the city, and only 17 percent of the after-school programs. This information leads us to believe that access to after-school programs is not evenly distributed across Saint Paul.

Furthermore, after-school program information is complex and unstandardized. Collecting information on after-school programs is time consuming and information can quickly become out-of-date. In order to spend less time collecting data and maintaining the database, we
suggest the Second Shift Initiative create an open-source database, or wiki, where program organizers can input and update information on their programs. This database can be used to create an online “virtual one-stop” for after-school programs.

Access

Access was defined as the ability for a student to find age-appropriate after-school program that was within walking distance—one half-mile—of their residence. Two methods were chosen to assess access. The “SATS method” counted the number of after-school program spaces within a half-mile radius for each student, based on the estimated maximum capacity of programs. The “composite method” incorporates the raw number of programs and student density along with program space.

The both methods showed general areas that repeatedly exhibited high or low access. Of course, specific examination of the maps and the situation on the ground is necessary for a more precise and accurate analysis. General areas identified as having high access by both methods include the West Side, St. Anthony neighborhoods. General areas of low access as found by each method include Downtown, Payne-Phalen, Battlecreek-Highwood, and along I-35E.

In addition to these spatial patterns, the maps show that access to after-school programs is markedly lower for high school students, perhaps because they tend to rely on their schools for after-school activities. Additionally, the maps show that athletic programs are the most widespread, and arts programs are generally the least available.

Conclusions

We offer three recommendations to the Second Shift Initiative:

1) Create an open-source database (a wiki) of after-school programs in Saint Paul.
   a. Program directors and organizers can add information directly to the database.
   b. Information can be updated by program organizers as needed.
   c. The Second Shift Initiative will spend less time collecting and maintaining data.
   d. This database can be adapted to create a “virtual one-stop.”

2) Investigate the demand for and availability of after-school programming within the three areas with: low accessibility and high numbers of students, high percentages of students of color, and high percentages of students receiving subsidized lunch (see Map D-1).
   b. Just north of I-94 between Midway and Thomas-Dale (block group 325003).
   c. East of highway 61 in Battlecreek-Highwood.

3) Increase access to current areas with high concentrations of programs through transportation initiatives (e.g. circulator buses).
# LIST OF MAPS

## A. Student Maps

<table>
<thead>
<tr>
<th>A-1</th>
<th>Students of Color</th>
<th>Page 17</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-2</td>
<td>Students Qualifying for Subsidized Lunches</td>
<td>Page 18</td>
</tr>
<tr>
<td>A-3</td>
<td>English as a first language</td>
<td>Page 19</td>
</tr>
<tr>
<td>A-4</td>
<td>Hmong as a first language</td>
<td>Page 20</td>
</tr>
<tr>
<td>A-5</td>
<td>Spanish as a first language</td>
<td>Page 21</td>
</tr>
<tr>
<td>A-6</td>
<td>Students speaking a language other than English, Hmong or Spanish as a first language</td>
<td>Page 22</td>
</tr>
<tr>
<td>A-7</td>
<td>Basic Battery Scores</td>
<td>Page 23</td>
</tr>
<tr>
<td>A-8</td>
<td>Basic Battery Scores by Category</td>
<td>Page 24</td>
</tr>
<tr>
<td>A-9</td>
<td>Math Scores</td>
<td>Page 25</td>
</tr>
<tr>
<td>A-10</td>
<td>Math Scores by Category</td>
<td>Page 26</td>
</tr>
<tr>
<td>A-11</td>
<td>Reading Scores</td>
<td>Page 27</td>
</tr>
<tr>
<td>A-12</td>
<td>Reading Scores by Category</td>
<td>Page 28</td>
</tr>
</tbody>
</table>

## B. After-School Program Maps

<table>
<thead>
<tr>
<th>B-1</th>
<th>Locations of After-School Programs</th>
<th>Page 36</th>
</tr>
</thead>
<tbody>
<tr>
<td>B-1a – B-1f</td>
<td>Neighborhood Maps of After-School Programs</td>
<td>Page 37</td>
</tr>
<tr>
<td>B-2</td>
<td>Academic Programs and Percent Students of Color</td>
<td>Page 43</td>
</tr>
<tr>
<td>B-3</td>
<td>Academic Programs and Percent of Students Qualifying for Subsidized Lunch</td>
<td>Page 44</td>
</tr>
<tr>
<td>B-4</td>
<td>Art Programs and Percent Students of Color</td>
<td>Page 45</td>
</tr>
<tr>
<td>B-5</td>
<td>Art Programs and Percent of Students Qualifying for Subsidized Lunch</td>
<td>Page 46</td>
</tr>
<tr>
<td>B-6</td>
<td>Athletic Programs and Percent Students of Color</td>
<td>Page 47</td>
</tr>
<tr>
<td>B-7</td>
<td>Athletic Programs and Percent of Students Qualifying for Subsidized Lunch</td>
<td>Page 48</td>
</tr>
<tr>
<td>B-8</td>
<td>Other Programs and Percent Students of Color</td>
<td>Page 49</td>
</tr>
<tr>
<td>B-9</td>
<td>Athletic Programs and Percent of Students Qualifying for Subsidized Lunch</td>
<td>Page 50</td>
</tr>
<tr>
<td>B-10</td>
<td>Distribution of After-School Programs by Age Group</td>
<td>Page 51</td>
</tr>
<tr>
<td>B-11</td>
<td>Distribution of Programs for K-4 Grade Students</td>
<td>Page 52</td>
</tr>
<tr>
<td>B-12</td>
<td>Distribution of Programs for 5-8 Grade Students</td>
<td>Page 53</td>
</tr>
<tr>
<td>B-13</td>
<td>Distribution of Programs for 9-12 Grade Students</td>
<td>Page 54</td>
</tr>
<tr>
<td>B-14</td>
<td>Free and Fee Programs and Students Qualifying for Subsidized Lunch</td>
<td>Page 55</td>
</tr>
<tr>
<td>B-15</td>
<td>After-School Program Capacity in Relation to Percent Students of Color</td>
<td>Page 56</td>
</tr>
<tr>
<td>B-16</td>
<td>After-School Program Capacity in Relation to Student Population</td>
<td>Page 57</td>
</tr>
<tr>
<td>B-17</td>
<td>After-School Program Capacity in Relation to Percent Students Qualifying for Subsidized Lunch</td>
<td>Page 58</td>
</tr>
</tbody>
</table>
C. Access Maps
C-1: All Student Access to All Programs (SATS)  Page 63
C-2: Elementary Access to All Programs (SATS)  Page 64
C-3: Middle School Student Access to All Programs (SATS)  Page 65
C-4: High School Student Access to All Programs (SATS)  Page 66
C-5: Elementary Access to Academic Programs (SATS)  Page 67
C-6: Elementary Access to Athletic Programs (SATS)  Page 68
C-7: Elementary Access to Arts Programs (SATS)  Page 69
C-8: Middle School Access to Academic Programs (SATS)  Page 70
C-9: Middle School Access to Athletic Programs (SATS)  Page 71
C-10: Middle School Access to Arts Programs (SATS)  Page 72
C-11: High School Access to Academic Programs (SATS)  Page 73
C-12: High School Access to Athletics Programs (SATS)  Page 74
C-13: High School Access to Arts Programs (SATS)  Page 75
C-14: All Student Access to All Programs by Raster (Composite)  Page 78
C-15: Elementary School Access to Programs by Raster (Composite)  Page 79
C-16: Middle School Access to Programs by Raster (Composite)  Page 80
C-17: High School Access to Programs by Raster (Composite)  Page 81

D. Conclusion Map
D-1: Block Groups with Consistently Low Access  Page 85

E. Reference Map
E-1: St. Paul Neighborhood Boundaries  Page 86
ACKNOWLEDGMENTS

We have learned a great deal from those who have worked with us and contributed to this project. We gratefully acknowledge Marnie Wells, coordinator of the Second Shift Initiative for the City of Saint Paul Division of Parks and Recreation, for providing us with the opportunity to work on this project, and Dr. Steve Schellenberg, of the Saint Paul Public Schools, for providing us with the necessary data and helping us understand the risks regarding data privacy issues. We would also like to thank Toni Smith and Dan Berchem, coordinators of Saint Paul Community Education Youth Programs, for meeting with us and discussing after-school programming with us.

In addition we would like to thank Dr. Holly Barcus for her assistance in designing and organizing the activity, Birgit Mühlenhaus for her technical and analytical assistance, Anna Shamey for her work making the initial connections to after-school programs and her technical support in the computer lab, the Macalester College Geography Department for allowing us to undertake such an important project, the Institutional Review Board and Provost Diane Michelfelder for identifying the potential of the project and approving the necessary privacy forms.
Introduction and Objectives

The Second Shift Initiative is a program of the City of Saint Paul charged with providing the youth of the city with viable options for after-school care. The name “Second Shift” refers to the 80% of the day students spend outside of the classroom.

To identify needs and gaps in after-school services, the Saint Paul Mayor’s Office, asked the Advanced Geographic Information Systems class at Macalester College to create a Geographic Information System (GIS) to look at access to after-school programs by Saint Paul Public School students. A GIS is a database of information connected to features in a map. Using GIS, characteristics and information about individual students can be mapped alongside characteristics and information about after-school programs. Advanced GIS students, under the direction of Geography Professor Holly Barcus, PhD, have been working on this project since February of 2007.

This project was divided into three sections, with one group of Macalester students working on each section: 1) information about students, 2) information about after-school programs, and 3) student access to after-school programs. The student group organized and analyzed the student data. This data consisted of where the students lived, their ages, their races, their test scores, and their status for free and reduced lunches. The after-school group collected information on as many after-school programs as possible. These programs ranged in size and scope and consisted of arts, sports, academic and other programs; programs focused for students of different ages; programs with different maximum capacities of students; and free programs and fee programs. The access group was responsible for compiling all of this data and creating a system to determine which groups of students are underserved by after-school programs.

This report will outline the procedure of the study and present the findings of the project. In particular the following objectives are covered in this report:

1. Carry out a local study to identify the location of after-school programs in Saint Paul.
2. Use these findings to map the locations of these after-school programs.
3. Use data provided by the Saint Paul Public School District to map concentrations of students in the different block groups of Saint Paul.
4. Use the demographic information (such as “first language” or “test scores”) of the students, provided by the Saint Paul Public School District, to map different aspects of the students in the block groups of Saint Paul.
5. Combine all the data about after-school programs and students to map and identify the relationship of where students live and where the programs are located.
6. Analyze accessibility of after-school programs to K-12 students, based on the students’ profile, the spatial distribution of the programs, and program characteristics.
DEFINITIONS

Access:
Broadly, the ability of a person to use a service. In this analysis, narrowed down to potential spatial accessibility. (See Potential Accessibility and Spatial Access)

After-School Program:
- Any program occurring during the afternoon, evening, night, or weekend of regular school weeks.
- Not including any programs taking place before school.
- Including programs taking place during summer vacations.
- Programs must meet at least once a week during the school year or for at least one week during the summer.

Block Group:
A subdivision of a census tract, generally containing between 600 and 3,000 people, with an optimum size of 1,500 people. Most block groups were delineated by local participants as part of the US Census Bureau's Participant Statistical Areas Program. It is the lowest level of the geographic hierarchy for which the US Census Bureau tabulates and presents sample data. (Census 2000 Geographic Terms and Concepts, 2000)

Composite Method:
A method that measures access by taking into account:
- The number of programs within Walking Distance
- The maximum capacity of those programs, measured in Spaces
- The number of students within the Block Group

Elementary Schoolers:
Students in grades K-4. School grade group divisions were made to approximate an even distribution of grades within the categories elementary (5 grades), middle (4 grades), and high school (4 grades).

Geographic Information Systems (GIS):
A computer system designed to allow users to collect, manage and analyze large volumes of spatially referenced information and associated attribute data. (Government of British Columbia, 2007)

High Schoolers:
Students in grades 9-12. School grade group divisions were made to approximate an even distribution of grades within the categories elementary (5 grades), middle (4 grades), and high school (4 grades).
Middle Schoolers:
Students in grades 5-8. School grade group divisions were made to approximate an even distribution of grades within the categories elementary (5 grades), middle (4 grades), and high school (4 grades).

Moran’s I Autocorrelation Analysis
The Moran’s I is a conventional measure of autocorrelation. It is used to detect departures from spatial randomness. Departures from randomness indicate spatial patterns such as clusters. Positive spatial autocorrelation generally indicates that nearby areas are similar, indicating spatial clustering. Values of I larger than 0 indicate positive spatial autocorrelation; values smaller than 0 indicate negative spatial autocorrelation (Jacquez, 1994).

Student of Color
Any student who, according to the student database provided by Saint Paul Public Schools, is not white.

Potential Accessibility:
The ability for services to potentially be reached by people.

Revealed Accessibility:
The degree to which people are actually reaching services.

Spaces:
The number of students that a particular program can enroll.

Spatial Access:
Ability of a person to use a service based on proximity. In this study proximity is defined as Walking Distance, or one half-mile.

Student Access to Spaces (SATS):
A method that measures how many program spaces are within Walking Distance of a student.

Walking Distance:
A one half-mile radius around an individual, not taking into account transportation opportunities.
STUDENT CHARACTERISTICS

Introduction
There were 43,331 students enrolled in Saint Paul Public Schools in grades K-12 in October of 2006. With the aim of learning more about these students to better understand their specific needs, we mapped student characteristics, such as whether the student was of color, their test scores, first language, and whether the student was receiving free or reduced lunch. The primary objective of mapping student characteristics was to be able to link students to an appropriate after-school program, and to be able to spatially determine where students with the highest need are located. The secondary aim was to identify if there is clustering of students with a certain characteristic, e.g. do students that have low test scores live in the same area. Locating clusters of students with similar characteristics can help identify locations for new programs that target particular demographics or need groups, for example; ESL, culturally appropriate programs, or tutoring opportunities.

Student Characteristics
Each of the 43,331 students student addresses were mapped (geocoded) using a GIS. This allowed each address, and the corresponding characteristics of each student, to be associated with a particular place on the map. Students who do not reside in the city of Saint Paul were excluded from the analysis as the objective of the project is to assess access to after-school activities within the City of Saint Paul.

Once mapped, individual student characteristics were aggregated to the block group level. A block group is a subdivision of a census tract, generally containing between 600 and 3,000 people, with an optimum size of 1,500 people. Most block groups were delineated by local participants as part of the US Census Bureau's Participant Statistical Areas Program. It is the lowest level of the geographic hierarchy for which the US Census Bureau tabulates and presents sample data. A block group was determined as the optimal scale of aggregation because it protects the privacy of the individual students, while still allowing meaningful analyses of spatial patterns and trends.

Map analysis and Evaluation
Students of color – Map A-1
In Saint Paul, the distribution of students of color range from 0% to 98% within a block group. Most neighborhoods show a wide variety of percentages of students of color. However, “St Anthony”, “Como”, “Summit Hill”, and “Macalester-Groveland” are notable exceptions. “Macalester-Groveland”, in particular, stands out on the map as an area with few students of color and it is in stark contrast to “Thomas-Dale”, which has a

1 This count of students does not include students enrolled in private schools or in charter schools.
3 See map D-1 on page 86 for neighborhood boundaries.
majority of students of color. Students of color are clustered in Central Saint Paul and the “West Side”. Students of color have been statistically shown to be clustered using spatial autocorrelation (Morans I\(^4\)). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

**Students Qualifying for Subsidized Lunches – Map A-2**

Students qualifying for subsidized lunches refer to those students who meet the criteria for free and reduced lunch based upon a number of variables. For example, students whose families are receiving Food Stamps, Minnesota Family Investment Plan, or Food Distribution Program on Indian Reservations, students who are foster children and students whose household income falls within the Federal Income Chart may qualify for subsidized lunches.\(^5\) A family of four who earns less than $37,000 a month may qualify for reduced-price lunches; to qualify for free lunches a family must earn less. On map “A-2”, there are large percentages of students qualifying for subsidized lunches north of the I-94 corridor in the “Thomas-Dale”, “Dayton’s Bluff”, “West Side” and Southern “Payne-Phalen” neighborhoods of Saint Paul. Between 80% to 96% of the students in this area qualify. Other areas with high percentages of students qualifying include “Midway”, “Summit-University”, “Downtown”, “North End”, “West Seventh”, “Greater East Side”, and “Battle Creek-Highwood” neighborhoods. About 48% to 79% of the students in these areas qualify for free and reduced lunches. In analyzing the spatial pattern of free and reduced lunches, an obvious pattern emerged; a statistically significant clustering occurs (Moran’s I\(^5\)). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

**English as a first language – Map A-3**

The largest concentration of children with English as a first language is in the “Macalester-Groveland”, “Merriam Park”, and “Summit Hill” areas. These are the same areas where there are a low percentage of non-white children. The distribution of children with English as a first language ranges from 21% to 100%. “Dayton’s Bluff”, “Greater East Side”, “Payne-Phalen”, eastern “Thomas-Dale”, and eastern “West Side” are areas of very low percentage of English speaking students, and never exceed 75% English speaking students. The English speaking students have been statistically shown to be clustered using spatial autocorrelation (Morans I). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

**Hmong as a first language – Map A-4**

The distribution of students that have Hmong as their first language is highly unbalanced as Hmong-speaking students are heavily concentrated to the Northeast part of the City of

\(^4\) The data is divided into five categories, and the classes are determined by natural breaks in the data.


\(^5\)Moran's I (Moran 1950) is a weighted correlation coefficient used to detect departures from spatial randomness. Departures from randomness indicate spatial patterns, such as clusters. Moran's I tests for global spatial autocorrelation in group-level data. Positive spatial autocorrelation means that nearby areas have similar rates, indicating global spatial clustering. Nearby areas have similar rates when their populations and exposures are alike. When rates in nearby areas are similar, Moran's I will be large and positive. When rates are dissimilar, Moran's I will be negative.
Saint Paul. The block groups with the highest student Hmong-speaking percentage are all clustered in the Northeastern part of the city, and the “Greater East Side”, “Thomas-Dale” and “Payne-Phalen” neighborhoods. The concentration of Hmong-speaking students reaches a maximum of 60% per block group, while the East part of the city has very low concentrations of Hmong speaking students as most block groups in this area have concentrations less than 16%. The Hmong speaking students have been statistically shown to be clustered using spatial autocorrelation (Morans I). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

**Spanish as a first language – Map A-5**
The distribution of Spanish speaking students is also unbalanced in the city of Saint Paul, between the East and the West of the city. While the “Macalester-Groveland” neighborhood lacks Spanish-speaking students, the East Side has a high concentration. The highest concentrations are located in the “West side” and in the southern block groups of “Highland”. The concentration of Spanish-speaking students reaches a maximum of 51% while in East Saint Paul the concentrations are generally below 8%. The Spanish speaking students have been statistically shown to be clustered using spatial autocorrelation (Morans I). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

**Students speaking a language other than English, Hmong and Spanish as a first language – Map A-6**
The students identified as speaking “other” languages as their first language are scattered across the City of Saint Paul. Students in this group have as their first language any language other than Spanish, Hmong and English. The most significant number of these students probably speaks Somali, as there are a noticeable number of Somali immigrants in Saint Paul. The “open category” of “other” as a first language is the reason for the great variability of the concentrations of this group within the city. The block groups with the highest concentration are in the “Merriam Park” and “Battlecreek-Highwood” neighborhoods, with concentrations reaching up to 70%. The Northeast part of Saint Paul has very low concentrations of “other” speaking students, while in the largest number of block groups in the city; the concentration rarely exceeds 11%. The students speaking languages other than Hmong, Spanish or English at home students have also been statistically shown to be clustered using spatial autocorrelation (Morans I). There is less than 1% likelihood that this clustered pattern could be the result of random chance (table 1).

Table 1. The table summarizes the Moran’s Index for clustering and the Z Score test of significance for maps A-1 to A-6.

<table>
<thead>
<tr>
<th>Map</th>
<th>Moran’s Index</th>
<th>Z Score (standard deviation)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-1</td>
<td>0.31</td>
<td>56.6</td>
</tr>
<tr>
<td>A-2</td>
<td>0.31</td>
<td>56.3</td>
</tr>
<tr>
<td>A-3</td>
<td>0.3</td>
<td>54.4</td>
</tr>
<tr>
<td>A-4</td>
<td>0.3</td>
<td>55.3</td>
</tr>
<tr>
<td>A-5</td>
<td>0.18</td>
<td>33.3</td>
</tr>
<tr>
<td>A-6</td>
<td>0.02</td>
<td>6.1</td>
</tr>
</tbody>
</table>
General Map Information:
The choropleth maps are based on the average score per student per block group. There were only slightly more than 14,000 students with scores on all tests so the data are somewhat limited. All scores are on a scale of 1-9 with 1 being a poor score and 9 being an excellent score. The SAT10 is given to students in grades 2 through 8 and in grade 9 in five of the seven high schools. The Math test includes two sections - Procedures (basically computation) and Problem Solving. The Reading test includes sections on Vocabulary and Reading Comprehension at all grade levels, with sections on Letters and Sounds at early grades. The Basic Battery score is the combination of the Math and Reading sections.

The Basic Battery Scores – Map A-7
The lowest scores are in the central portions of the map. “Como”, “Summit-Hill” and “Macalester-Groveland” are the highest scoring neighborhoods for this test. Excluding the block groups with 50 students does not alter the overall map much and it appears to be similar to the version of the map before excluding these block groups. These block groups would be disregarded to reduce the distortions that using statistical averages over a small sample size can create.

Basic Battery Scores by Category – Map A-8
This map includes the block groups that scored above average (7-9) on the Basic test. The block group with the fewest students that still scored above average as a whole had only 6 students, while the block group that scored above average and had the most students had 51 students. No block groups to the east of downtown scored above average as a whole.

Math Scores – Map A-9
This map shows the test scores for the “Math” exam. The highest average scores are in the “Macalester-Groveland” neighborhood, but there are also high scores in “Summit-Hill”, “Como” and “Highland”. The lowest scores are in the central portion and the “West Side” neighborhood.

Math Scores by Category – Map A-10
Almost all the “Macalester-Groveland” block groups scored above average on the Math test. Quite a few in “Summit-Hill” and “Como” performed well too. Like in the basic scores map, no block groups to the east of downtown scored above average as a whole.

Reading Scores – Map A-11
This map shows the test scores for the “Reading” exam. The highest average scores are in the “Macalester-Groveland” neighborhood, but there are also high scores in “Summit-Hill” and “Highland”. The lowest scores are in the central portion around “Downtown” and “Thomas-Dale” and the “West Side” neighborhood.

Reading Scores by Category – Map A-12
Almost all the “Macalester-Groveland” block groups scored above average for Reading. Quite a few in “Summit-Hill” and “Como” performed well too. Like in the basic and math scores maps, no block groups to the east of downtown scored above average as a whole.
Overall Conclusions
Examination of the maps A-1 to A-12 gives indications as to the race, first language and test scores of students relative to an economic indicator such as the qualification for subsidized lunch. Despite that the “subsidized lunch” might not be the most effective way to determine the economic status of a student it is evident from the maps that certain areas with non-English speaking, non-white students tend to have higher concentration of students that are eligible for subsidized lunch. Such areas include block groups of the “West Side”, the “East Side” and the “Thomas Dale” neighborhoods. The students in these areas also tend to perform poorly in the standardized tests.

The areas identified above seem to have the lowest economic level and the lowest academic performance level, in addition to being ethnic neighborhoods. These areas require special attention during policy making in an effort to increase the economic status of the neighborhoods and to achieve better academic performance among the students.

Summary
Mapping and analyzing student data is an important process in the effort of identifying student access patterns in the city of Saint Paul. The student characteristics group had a database of more than 43,000 students and their demographic characteristics. The task of the student group was to place the student addresses on the map of the city of Saint Paul using a process called geocoding. After finishing the geocoding process of the 43,000 student records, about 92.5% of the students were shown on the map. The remaining addresses were not geocoded either because the students did not actually live in Saint Paul, or because the addresses did not allow the geocoding process to take place. After all the students were spatially placed on the map, the demographic characteristics of each student (including age, first language, race, test scores and qualification for subsidized lunch) were attached to the mapped student addresses. The Saint Paul Public School district provided these data.

The manipulation of the student data and the mapping process resulted in a set of maps that show the student demographics in the city of Saint Paul. The maps were used to describe the spatial distribution of the students in the block group level. Maps for the percentage of non-white students and students with subsidized lunch in each block group were produced. In addition, maps of the first language of students for each block group were produced, for the categories “English-speaking”, “Spanish-speaking”, “Hmong-speaking” and “Other”. Finally, the academic performance of the average student in each block group was examined using the maps of “Basic”, “Math” and “Reading” scores provided by the Saint Paul Public School district.

The analysis of the maps provided helpful insights about the relationships between the characteristics of the students living in the various block groups of Saint Paul. Clustering analysis of the characteristics indicate the students are statistically significantly clustered. Also, by comparing the maps of the different characteristics, it is evident that some demographic characteristics are related. Neighborhoods of high percentage of non-white student populations, such as the East Side, also show low percentage of English speaking
students. In addition, the areas of high non-white student population correlate with areas of high percentage of students that qualify for subsidized lunches and often with areas where students perform below average in standardized scores. Examples of neighborhoods that show these characteristics include the Thomas Dale and the West side neighborhood. These areas seem to have the lowest economic level and the lowest academic performance level, in addition to being ethnic neighborhoods. These areas require special attention during policy making in an effort to increase the economic status of the neighborhoods and to achieve better academic performance among the students.
Average Student "Basic" Score
Saint Paul Public Schools, Minnesota

Average "Basic" Test Scores by Block Group

- 3.90 - 4.70
- 4.71 - 5.00
- 5.01 - 5.60
- 5.61 - 6.70
- 6.71 - 8.40

Map credits:
Macalester College
C3OG3564
8 April 2007
Data Source: ESRI
Saint Paul Public Schools, US Census
Average Students With Above Average "Basic" Scores

Saint Paul Public Schools, Minnesota

Block Groups Where the Average Student Scored Above Average

Above Average
Students With Above Average Math Scores
Saint Paul Public Schools, Minnesota

Block Groups Where the Average Student Scored Above Average

Above Average
AFTER-SCHOOL PROGRAMS

Introduction

In 2005, the Brookings Institute reported in *Mind the Gap: Disparities and Competitiveness in the Twin Cities*, that the quality of life, economic strength, and access to social services, often considered the pride of the metropolitan area, is not distributed evenly across its residents. In particular, the report identified three areas where this gap is very significant: 1) between racial and ethnic groups, 2) between socio-economic classes, and 3) between relatively wealthy suburbs and urban areas where poverty is concentrated. Working to decrease these disparities was identified as an important way for the Twin Cities to maintain its economic competitiveness and increase its strength in the coming decades (Brookings Institute, 2005).

The Second Shift Initiative, a program of Saint Paul Mayor Chris Coleman, was established to reduce these racial, economic, and spatial disparities within kindergarten through twelfth graders in Saint Paul. In order to increase access to educational, athletic, artistic, and social programs during the eighty percent of students’ time spent outside of the classroom, The Second Shift Initiative works to 1) identify needs and gaps in services, 2) gather and disseminate information and best practices, 3) coordinate current programs and partnerships in an effort to eliminate duplication of services, 4) effect policy change, and 5) inform resource allocation (Saint Paul Second Shift Initiative, 2006). Our work exploring where after-school programs in Saint Paul are located in relation to where students live works to identify needs and gaps in after-school services.

In order to explore the relationship between where students live and where after-school programs are in Saint Paul, we set out to gather the locations of after-school programs in Saint Paul. For each after-school location, we attempted to gather descriptive data about these locations, such as the maximum number of students the site could hold and the types of activities available. We gathered information about after-school programs and locations for two months and spent one month organizing and analyzing this data. We created maps that show where programs are, types of programs offered, ages served by programs, cost of programs, and capacities of programs.

Methodology

Defining “After-School Program”
In consultation with Marnie Wells, coordinator of Saint Paul’s Second Shift Initiative, we have defined after-school programs as any program occurring during the afternoon, evening, night, or weekend of regular school weeks. We did not include any programs taking place before school, but we included programs taking place during summer vacations. Additionally, included programs must meet at least once a week during the school year or for at least one week during the summer.
Because we are representing the data spatially on maps, we aggregated all collected data to a location level. For example, if an agency organizes 2 sports classes, 3 art classes, and 1 language class per week at one location, we would group all 6 classes together and enter that data in one entry for that location.

**Data Collection**

After determining what constituted an after-school program, we decided what information we would collect about each of the programs. At first, we attempted to collect a broad range of information about each after-school program. We quickly realized we did not have the time or resources to collect such a large amount of information, and we narrowed the scope of our data collection. The original information we attempted to collect is included in Technical Appendix B.I.

We narrowed the data collection to the categories that we thought we be most useful in our analysis. The final information we collected included:

- Agency Name
- Contact Name, e-mail, phone number
- Address
- If the activity was classified as art, academics, athletics or other
- The grades the program served
- How often the program met
- Cost
- The maximum capacity of the program

These categories were the most useful in our analysis for this project. Since one of the goals of the project was to analyze access to after-school programs, maximum capacity and cost of programs were particularly important variables to collect. Specific information about how each of these categories was defined is available in Technical Appendix B.II.

Additionally, because our time was limited, we focused on collecting after-school programs with open enrollment. We chose to focus our attention open enrollment programs for two reasons: 1) these programs are accessible to all students and 2) school-sponsored, closed-enrollment programs are generally well publicized at sponsor schools. As a result, programs like high school sports teams and theater programs were not included. With additional time and resources, we would have liked to collect more information about more programs.

**Contacting Programs**

We found programs through a variety of venues. We searched the internet, spoke with Saint Paul Community Education, consulted neighborhood commissioners for the Saint Paul Second Shift Initiative, reviewed lists of local education grant recipients and a list of after-school activities from the Civic Engagement Center at Macalester College, and contacted community organizations (e.g. Parks and Recreation, Boys and Girls Club, Jewish Community Centers, etc). We know that our list of after-school programs, while extensive, is not comprehensive. It is a foundation for further data collection.

After searching for available program information online, we began to contact the programs. If the website had an e-mail address we sent a standard e-mail explaining the
project and a short list of questions about the information we hoped to collect. We received information from some of the programs within a few days, while other programs did not respond or did not have an e-mail address. If we did not receive a reply or could not contact the program by e-mail, we called the programs to gather the information. We started calling after we reduced the amount of information to be collected, which made it easier to quickly gather information over the phone. In addition to e-mail and phone calls, we also scheduled a meeting with Toni Smith and Dan Berchem, Coordinators of Saint Paul Community Education Youth Programs (Interview, 2007). From this meeting we were able to collect data about Community Education Programs at specific locations around Saint Paul.

**Organizing the Data**
The data was organized in a Microsoft Access database. Additional information about the creation and management of this database is available in Technical Appendix B.II.

**Results**
Maps of after-school programs are divided into 5 groups: 1) locations of after-school programs, 2) types of programs offered, 3) ages served by programs, 4) costs of programs, and 5) capacities of programs. A list of all maps made, explanations of calculated statistics, explanations of how choropleth categories were created, and information regarding software and files are included in the technical appendix B.III.

**After-School Programs by Location:** Map B-1
Map B-1 shows the overall distribution of collected after-school programs across Saint Paul. Maps B-1a – B-1f show the distribution of programs within selected neighborhoods of Saint Paul.

**After-School Programs by Type of Program:** Maps B-2 – B-9
The distribution of programs by type of program is mapped over choropleth maps showing percent students qualifying for subsidized lunch by block group and percent students of color by block group. All maps show a large concentration of block groups with a high percent of students qualifying for subsidized lunch and students of color above I-94 and to either side of I-35E. In this area no after-school programs of any category take place.

**Academic Programs: Maps B-2 and B-3**
We identified 56 academic after-school programs in Saint Paul. The programs are distributed across block groups with high to low percentages of students receiving subsidized lunch and of students of color. All neighborhoods have at least one academic program except Summit-Hill, although programs are located nearby in other neighborhoods. Statistically significant clustering takes place with academic programs. St. Anthony, Highland, Summit-University, Como, North End and Payne-Phalen all have academic programs located relatively close to each other.
Art Programs: Maps B-3 and B-4
Through our data collection we identified 45 after-school art programs in Saint Paul. Art programs are located in block groups with both low and high percentages of students qualifying for subsidized lunch and of students of color. All neighborhoods have at least one program with the exception of Summit Hill. Although it appears that the art programs could be clustered, their distribution across Saint Paul is random and statistically clustering does not take place.

Athletic Programs: Maps B-4 and B-5
The 69 athletic after-school programs we identified take place in block groups with high to low percentages of students qualifying for subsidized lunches and of students of color. Downtown is the only neighborhood without at least one athletic program. The spatial distribution of athletic programs can also be classified as clustered. Neighborhoods with clusters include West Seventh, Macalester-Groveland, Summit-University, North End, Payne-Phalen and Greater East Side neighborhoods.

Other Activities: Maps B-5 and B-6
We collected information on a total of 56 programs falling into the category of “other.” Other programs are also dispersed across all block groups. Every neighborhood has at least one other program except Battlecreek-Highwood and Summit Hill. The other programs also follow a statistically significant clustering pattern seen in the other categories except art. The clustering is seen in Highland, Downtown, Payne-Phalen, Como and Summit-University.

After-School Programs by Age: Maps B-10 – B-13
Maps B-10 – B-13 show the distribution of all after-school programs by age group. Maps B-11 – B-13 focus on specific age groups: K-4, 5-8, and 9-12.

Of the 112 programs, 109 of those programs target kindergarten through 4th grade, 96 programs target 5th through 8th grade students and 56 programs target 9th through 12th grade students. In the “Distribution of After-School Programs by Age Group” map there are 49 locations that have programs available for all age groups. Just 12 locations offer programs for only elementary students, 3 locations offer programs for only High School students, and 48 locations offer programs for Elementary and Middle School students.

Overall, programs are fairly evenly distributed across the city with a few gaps in Battle Creek Neighborhood and around I-35 E North of downtown. Within each age category the programs are also distributed throughout the city. There are no neighborhoods with zero programs, but distribution is not necessarily even. These maps do not take into consideration the number of students in each neighborhood or the number of students within each age group in each neighborhood.

After-School Programs by Cost: Map B-14
Map B-14 shows the distribution of after-school programs by cost. There are 39 locations that only offer programs with a fee. There are 9 locations that offer both fee and free programs. There are 49 locations that only offer free programs. Free programs are clustered in particular areas of Saint Paul. Fee programs are randomly dispersed.
After-School Locations by Capacity: Maps B-15 – B-17

Maps B-15 – B17 show the maximum capacities of students for each after-school program and demographic information about students.

Map B-15 shows the capacity of after-school programs in relation to the percentage of students of color in the block group. Again, the 10 percent of the block groups with the highest numbers of students of color account for 28 percent of the students in Saint Paul, and have 16 percent of the after-school programs.

Map B-16 shows student population of block groups and student capacity at each after-school location. Darker colors signify higher populations of students. The capacity of the programs is presented with proportional symbols, meaning that the larger the circle the higher the capacity for the program. Ideally, the areas with the highest student population would have the most after-school programs. The 10 percent of block groups with the highest student populations have 28 percent of the students in Saint Paul. These same block groups contain only 17 percent of the after-school programs. This statistic seems to indicate that the after-school programs are not placed in the areas with the largest numbers of students.

Map B-17 shows after-school program capacity in relation to students receiving subsidized lunch. The point of this map is to show whether block groups with high rates of students receiving subsidized lunch have reasonable access to after-school programs. The 10 percent of block groups with the highest numbers of students have 28 percent of the students receiving free lunch. These block groups have only 15 percent of the after-school programs in Saint Paul.

Conclusion

Sources of Error
Collecting data on after-school programs in Saint Paul was difficult due to the nature of after-school programs and to our two month time limit for collecting data. As a result, though we were able to draw conclusions about after-school programs in Saint Paul, our data is not without error. Our data about after-school programs is incomplete. We were unable to identify all of the after-school programs in Saint Paul and had difficulty collecting all of the data we had originally hoped to collect. Our data collection would be more complete if we were not constrained by our one semester time limit. Because our sample is skewed, our conclusions regarding the data are not necessarily representative of after-school programs in Saint Paul as a whole, but only of our sample of programs.

The map comparing the locations of sites offering all free programming, some free programming, and all fee-based programming and the percentage of students on subsidized lunch provides only a minimal amount of information about the availability of low cost programming. Because of the diverse ways that costs are determined by programs and reported to us, it is difficult to present the complexity of this data in a map. Programs may charge by the day, week, month or year. Fees may be lower for those with memberships to the given agency, but still open to non-members. The cost reported may
cover an hour's worth of supervision or four hours a day, five days a week, all year long. Because of this complexity, it was impossible to construct a meaningful range of costs (e.g., $0-20, $20-40, etc.) as we had originally imagined. The only distinction that could be made was between free and fee-based programs. Because of this, some very low-cost programs are included in the category "fee-based."

Using location as a unit of analysis also presents some challenges. Not all programs are easily represented by simply plotting a point on a map. For example, a summer program in the West Side changes locations frequently so the children can see and better understand different areas of their neighborhood. Because it changes location, representing this type of program on a map can be misleading. If every location were mapped, it would appear as if many programs took place in the West Side but a single point is also not representative of the program. Also by using single points, it is hard to tell which organizations run programs at many locations and what exactly goes on at a location at any given time.

Additionally, throughout data collection we realized that after-school programming in Saint Paul happens at a variety of frequencies. Our sample includes programs that occur one day a week for 12 months, five hours a day for a week, and three hours a week for three months. Frequency is not standardized across all after-school programs in Saint Paul, and therefore program types, costs, age groups, and capacities change from school year to summer, quarter to quarter, week to week, and day to day.

**Data Limitations and Strengths**

Unfortunately, prior to the initiation of this project, no central database for after-school programs existed. At the start of the project, we hoped that we would be able to contribute a complete and comprehensive database to the Saint Paul City Government. However, time and expertise restrictions arose that made it impossible for us to create this “virtual one-stop shop.” Instead, what we are able to contribute is a database reflecting and intensive two-month data collection effort which can serve as a starting point for further data collection.

To address the limitations of time-specific data collection strategies, we recommend that the City of Saint Paul design and implement an open-source database or wiki⁶, in which directors of after-school programs can access the database and enter their own data. In our interviews and communications about after-school programs, organizers expressed interest in and support for such a database. This would be a relatively quick and easy way to build and maintain a complete database on after-school programs. For an outside player, such as the advanced GIS class of Macalester College or an intern with the Second Shift Initiative, to accurately collect data on all the after-school programs is unrealistic. The process of collecting this data will take large amounts of time to complete and maintain. Providing an open-source database would allow directors to update their programs as necessary and allow directors of programs to decide how they would like to classify the frequency, cost, capacity, etc of their programs.

---

⁶ A wiki is a website where visitors can add, update, and edit information.
Benefits to an open-source database:
- Program directors and organizers can add information directly to the database.
- Information can be updated by program organizers as needed.
- The Second Shift Initiative will spend less time collecting and maintaining data and have more time to work on policy.
- This database can be adapted to create a “virtual one-stop”.

Despite the challenges to collecting data about after-school programs and the limitations of standardizing after-school program information, our data begins the important and significant process of collecting information on after-school programs in Saint Paul. This data is a first step towards the much larger goal of centralizing after-school information. Centralized information about after-school programming in Saint Paul will give policy makers and residents the knowledge needed to support existing programs and aid in the creation of new programs in underserved areas.

**Policy Considerations**
Considering the above sources of error, we were able to draw a few general conclusions. It appears that after-school programs in general are clustered, meaning that neighborhoods that have some after-school programs are likely to have many while others have fewer. Furthermore, there are neighborhoods that are likely to have few or no programs. The Mount Airy housing development near downtown Saint Paul is an example of an area with very few after-school programs, whereas the Payne-Phalen area has a high density of programs. Overall, the programs are not located in the block groups where the majority of the students live. The 10 percent of block groups with the highest student populations have 28 percent of the student population of the city, and only 17 percent of the after-school programs.

There appear to be fewer options for after-school programs that focus on arts, as opposed to sports and academic programs. Additionally, there are fewer options available for high school students, although programs hosted by high schools explicitly for students enrolled in the school were not included in the analysis.
After-School Programs in and around the Thomas-Dale and North End Neighborhoods
Saint Paul, Minnesota
After-School Programs In and Around Payne-Phalen, Dayton's Bluff, and the Greater East Side

Saint Paul, Minnesota

Map showing locations of after-school program sites in and around Payne-Phalen, Dayton's Bluff, and the Greater East Side in Saint Paul, Minnesota. The map highlights various community centers, libraries, and educational institutions, as well as other key areas such as Payne-Phalen, Greater East Side, Dayton's Bluff, and Battle creek-Highwood.
After-School Programs In and Around Battlecreek-Highwood
Saint Paul, Minnesota
After-School Programs In and Around Merriam Park, Macalester-Groveland and Highland Neighborhoods

Saint Paul, Minnesota

Map of After-School Program Sites in and around Merriam Park, Macalester-Groveland, and Highland Neighborhoods in Saint Paul, Minnesota.
Academic Programs and Percent of Students Qualifying for Subsidized Lunch
Saint Paul, Minnesota

Percent Qualifying for Subsidized Lunch by Block Group
- 0% - 23%
- 24% - 47%
- 48% - 65%
- 66% - 79%
- 80% - 96%

Academics
Art Programs and Students Qualifying for Subsidized Lunch
Saint Paul, Minnesota

Percent Qualifying for Subsidized Lunch by Block Group
0% - 23%
24% - 47%
48% - 65%
66% - 79%
80% - 96%

Art Programs
Other Programs and Students Qualifying for Subsidized Lunch
Saint Paul, Minnesota

Percent Qualifying for Subsidized Lunch by Block Group
- 0% - 23%
- 24% - 47%
- 48% - 65%
- 66% - 79%
- 80% - 96%

Other Programs

Macalester College
GEOP394
9 April 2007
Data Source: ESRI, Saint Paul Public Schools, U.S. Census
Distribution of After-School Programs by Age Group

Saint Paul, Minnesota

Targeted Ages for Program
- All Ages (K-12)
- Elementary Only (K-4)
- Elementary and Middle School Only (K-8)
- High School Only (9-12)

*There were no programs targeting Middle School only or Middle and High School only.

Macalester College
April 11th, 2007
Data Sources: ESRI
University of Minnesota
Distribution of Programs for Kindergarten to Fourth Grade Students

Saint Paul, Minnesota

- Locations with K-4th Grade Programs

Location may not have programs for every grade (K-4), but has at least one program serving this age group.

Macalester College
April 12th, 2007
Data Sources: ESRI, University of Minnesota

0 0.5 1 2 Miles
Distribution of Programs for Fifth to Eighth Grade Students

Saint Paul, Minnesota

Locations with 5th-8th Grade Programs
Location may not have programs for every grade (5-8), but has at least one program serving this age group.

Macalester College
April 12th, 2007
Data Sources: ESRI, University of Minnesota
Distribution of Programs for Ninth to Twelfth Grade Students

Saint Paul, Minnesota

- Locations with 9th-12th Grade Programs
  Location may not have programs for every grade (9-12), but has at least one program serving this age group.

Macalester College
April 12th, 2007
Data Sources: ESRI, University of Minnesota
After-School Programs Capacity in Relation to Student Population

St Paul, Minnesota
ACCESS TO AFTER-SCHOOL PROGRAMS

Introduction

The task of assessing access was performed independent of the analysis of the Saint Paul Public School student body and the analysis of after-school programs. Access was defined as the ability for a student to find an after-school program appropriate for their age group within walking distance of their residence. We defined walking distance as one-half mile from the home address listed in the Saint Paul Public School database. Student data was analyzed at the individual level and aggregated to the census block group level for presentation because of data confidentiality.

Two methods were chosen to assess access. One method—the student access to spaces method (SATS)—counted the number of after-school program spaces within a half-mile radius for each student, based on the estimated maximum capacity of programs. An average number of spaces within walking distance was then determined for each block group. Using this method, we created thirteen maps, looking at both specific age groups and specific program types.

While the SATS method directly considered the capacity of nearby programs, it did not account for the number of students in a block group or the number of different programs. A second method—the composite method—was chosen to incorporate these two factors in addition to program space. We made four maps using this method, assessing access to programs overall and for three different age groups.7

In comparing the results of both analyses it becomes apparent that certain block groups in Saint Paul have relatively low access to after-school programs.

Literature Review

There has been very little work published on spatial student access to after-school programs. In an effort to find which methods would best fit our project, we turned to general resources for calculating access using Geographic Information Systems (GIS). We found the most relevant work concerned patient access to health care services.

Access has been defined in several ways. Penchansky and Thomas argue that “access is most frequently viewed as a concept that somehow relates to consumers’ ability or willingness to enter into the health care system” (1981: 128). Access can be broken down into several dimensions: availability, accessibility, accommodation, affordability, and acceptability. Joseph and Phillips (1984) also distinguish between potential accessibility—whether or not people have access to a service—and revealed accessibility—whether or not people are, in fact, utilizing a service. With these

7 Block groups with fewer than 50 students are indicated on all access maps, as those interpreting the maps may choose to give more attention to block groups with more substantial populations.
definitions in mind, our task was to examine Saint Paul students’ potential spatial accessibility to after-school programs, without regard to factors such as affordability and acceptability.

Potential spatial accessibility has been measured in numerous ways. Some researchers simply calculated the distance between a person and their single nearest service, while others would count the number of service providers in a defined area, and divide by the number of people seeking service. Another method was to determine a radius around a point representing either a person or a group of people, and counting how many providers fell into this distance. Luo and Wang (2003) developed a model taking into account both the spatial access of patients to doctors and of doctors to patients, where providers which are closer to patients are weighted as more accessible than those further away. Other researchers have taken a similar approach to weighting service providers based on “attractiveness,” but they have defined attractiveness in ways other than raw distance, such as the size of the service provider or the type of services they render. All of these methods have validity, and a careful analysis of one’s particular research questions should precede the selection of any particular method.

**Student Access to Spaces (SATS)**

**Methods & Limitations**

In this method, we used GIS to calculate the number of after-school program spaces within walking distance of each student, based on the estimated maximum capacity of programs, and then determined the average number of spaces for students in each block group. The result was a unique value for each block group representing the average number of program spaces within walking distance of that block group’s student population. Block groups with low values are considered to have lower access than block groups with higher values.

We defined “walking distance” to be one half-mile, as the crow flies, because this is the maximum distance that public school students are expected to walk to their school bus routes. In doing so, we are making the assumption that students will not travel more than one half-mile to seek programs.

This method was chosen because it looks at access from the point of view of the individual students. By measuring the number of program spaces instead of the number of programs, we are in essence creating a model where programs are weighted according to their maximum capacity. In contrast to other models of access, we decided not to take distance into account beyond whether or not they were within walking distance. Because one half-mile is already such a short distance, it seemed that variation within that range would have little to no effect on actual accessibility.

We used the SATS method with many combinations of related programs and students—for example, ‘elementary students’ and ‘programs that serve elementary-schoolers and have arts programs’—to make thirteen different maps. Each map displays five different levels of access, but it should be noted that these levels do not represent the same numeric values on every map. This means that of these thirteen maps, only those that
have identical legends can be placed side by side and compared with each other without interpretation and qualification.

When interpreting maps C-1 through C-13, it is important to recognize that they only display potential spatial access of program spaces to the students. That is, *how much program space is within walking distance of the student*, without taking into consideration the actual use of the programs, the interests of the students, affordability of programs, the number of students within the programs’ catchments, or even students’ knowledge of the existence of these programs. Because this measure of access is dependent on the student dataset and the after-school program dataset, all of the limitations mentioned in those respective sections apply here as well.

There are several other notable limitations that are specific to this method. Firstly, this method doesn’t account for the possibility of a program filling up. That is, if a program with 1000 spaces had 5000 students within a half mile of it, this method would say that each of those 5000 students have 1000 spaces available to them, even though there would actually be a shortage.

Secondly, when making maps specific to certain age groups and program types—for example, “Middle School Access to Academic Programs”—we performed analysis using the same raw data for all relevant programs (in this case, all programs that served middle schoolers and had academic programs). This means that if a recreation center was able to serve 650 students of all ages and had programs of all types, it would be counted in this example as having a middle school academic program for 650 students, even though it’s possible that this recreation center only had space for 50 in its academic program for middle schoolers.

Thirdly, both summer and school year programs were included in the analysis, even though they wouldn’t actually add to the number of program spaces at any given time.

Finally, this method provides no way to account for the number of times each program meets, which vary from daily to monthly.

**Maps & Evaluation**
Maps were made in sets for comparison. Three maps compare access to all programs across the three grade level groupings. In addition, maps within each of the grade level groupings were produced to compare access to the three areas of programming.

**Maps:**
A. All Students to All Programs (C-1)
B. Maps showing access by grade level groupings:
   Elementary Student Access to Programs (C-2)
   Middle School Student Access to Programs (C-3)
   High School Student Access to Programs (C-4)
C. Maps showing elementary school access to programs for elementary schoolers
   Elementary Access to Academic Programs (C-5)
   Elementary Access to Athletic Programs (C-6)
   Elementary Access to Arts Programs (C-7)
D. Maps showing middle school access to programs for middle schoolers
Examining the access of all student grade levels (C-1) to all after-school programs reveals the general areas where program spaces are relatively limited. Overall there are six main areas where there are over 350 program spaces which relate to a high level of perceived access. In these areas there is a greater availability of program spaces to students than in other parts of city. Relatively low access can be seen in block groups along 35E in the eastern edge of the North End neighborhood, in the western edge of the Payne-Phalen neighborhood, and in portions of the Como, Highland, and Battlecreek-Highwood neighborhoods.

Looking more closely at access by grade level, elementary students and middle school students have greater access to programs than high school students (C-2, C-3, C-4). High school program spaces are primarily focused in five neighborhoods: the West Side, Payne-Phalen, Como, and Saint Anthony (C-4). Areas in between the neighborhoods with concentrations of high school programs—as compared to the same areas for middle and elementary school students—have the fewest program spaces available.

Maps of access according to program type (C-5 through C-13) show that within each age group there is a tendency for higher access to athletic programs than academic or arts-related programs. The Highland neighborhood, for example, has a high number of athletic program spaces but few academic or arts program spaces. Overall, across grade level groups, academic programs have the least representation, in terms of spaces. Athletic programs have the greatest spread of program spaces which suggests that access to athletic programs is greatest.

Overall, this method of assessing access shows how many program spaces there are in each block group and succeeds in illustrating an ideal landscape. However, because it does not account for the student population of each block group or other factors, its interpretation is limited to defining access in terms of available spaces. The Composite Method (see page 76) continues the method in this analysis but adds other factors to determine access based on potential demand.
Elementary Student Access to Programs
Saint Paul, Minnesota

Average Student Access to Program Spaces
- Less than 70
- 70 - 156
- 156 - 256
- 256 - 411
- More than 411
- Block Groups With Under 50 Students

Map data from ESRI, Saint Paul Public Schools, US Census

Macalester College
GEOG364
20 April 2007
Data Source: ESRI

Legend:
- Less than 70
- 70 - 156
- 156 - 256
- 256 - 411
- More than 411
- Block Groups With Under 50 Students
Middle School Student Access to Programs

Saint Paul, Minnesota

Average Student Access to Program Spaces

- Less than 70
- 70 - 156
- 156 - 256
- 256 - 411
- More than 411

Block Groups With Under 50 Students

Macalester College
GEOG3664
20 April 2007
Data Source: ESRI
Saint Paul Public Schools, US Census
Elementary Access to Arts Programs
Saint Paul, Minnesota

Average Student Access to Program Spaces
- Less than 45
- 45 - 122
- 122 - 237
- 237 - 439
- More than 439

Block Groups With Under 50 Students
- Relevant Programs
Middle School Access to Athletic Programs
Saint Paul, Minnesota

Average Student Access to Program Spaces

- Less than 52
- 52 - 128
- 128 - 248
- 248 - 449
- More than 449

Block Groups With Under 50 Students

Relevant Programs

Map Legend:

- 0
- 0.5
- 1
- 2 Miles

Data Source: ESRI
Saint Paul Public Schools, US Census

Macalester College
GEOG364
22 April 2007
Middle School Access to Art Programs
Saint Paul, Minnesota

Average Student Access to Program Spaces

- Less than 52
- 52 - 128
- 128 - 248
- 248 - 449
- More than 449

Block Groups With Under 50 Students

Relevant Programs

Source: ESRI
Macalester College
GEGG364
22 April 2007
Data Source: ESRI
University of Minnesota, US Census
High School Access to Athletic Programs
Saint Paul, Minnesota

Average Student Access to Program Spaces

- Less than 41
- 41 - 114
- 114 - 202
- 202 - 333
- More than 333

Block Groups With Under 50 Students
Relevant Programs

0 0.5 1 2 Miles

Macalester College
GEOG3664
20 April 2007
Data Source: ESRI
Saint Paul Public Schools, US Census
Composite Method

Methods & Limitations
This method allows us to create an index of access that accounts for several different factors at once. Essentially, three layers of maps are created and then combined into one map using what is known as “raster data.” Each layer can be given a different weighting based on the importance of that factor. The result is an index of accessibility. Darker colored areas have higher accessibility to after-school programs and lighter colored areas have lower access. For these maps, three factors were taken into account and given the following weighting:

1. The Number of Programs (40 percent weight)
   *Explanation:* This calculates the average number of programs each student has access to and serves as a proxy for diversity of programs. The greater the number of programs, the more choices a student will have for what to do with their after-school time. This factor was given a slightly higher weighting because we assumed that the simple presence or absence of a program would be the greatest factor determining access and that each program may not be filled to capacity.

2. The Number of Program Spaces (30 percent weight).
   *Explanation:* This variable accounts for programs with different capacities, or the supply of after-school activities. It calculates the average number of program spaces each student has access to, much like the student access to spaces method previously did.

3. The Number of Students (30 percent weight).
   *Explanation:* This variable takes the student population, or the demand for after-school activities) into account. We reason that the higher the number of the students in an area, the greater the competition for programs, and the lower the access for each individual student. Unlike the other two variables, a higher value for this variable counts against the measure of access.

Please see the technical appendix for the complete methodology.

The data has been classified so that all of these maps can be compared with each other. However, in classifying the data in this way, less specificity exists over the precise locations of lower access within each age group. For example, you may see overall that high school students have lower access to after-school programs than elementary school students, but within the high school map, more areas may have a level “2” or “3” access.

Maps & Evaluation
The composite method provided similar representations of access to the SATS method. Unlike SATS, however, this calculation of access yields a few small areas of consistently low access across the city of Saint Paul. By taking three variables into account—student density, program availability, and program capacity—this calculation of access may give a broader view of what areas in Saint Paul are under served. All student access (C-14) to all programs shows no area in Saint Paul with the lowest access rating of “1”, but when maps are broken down by age group, differences in access become apparent.
All three maps by age show similar areas of low access as calculated by the raster access index. Four areas in particular appear across age groups as areas with the least access (an index value of “1”). These areas are located in the Downtown neighborhood at the intersection of Interstate 35E and Interstate 94, in the Payne-Phalen neighborhood east of Interstate 35E, in the Battlecreek-Highwood area east of Highway 61, and along the border between Thomas-Dale and Midway neighborhoods. These areas of low access warrant further investigation.

<table>
<thead>
<tr>
<th>Access Rating</th>
<th>Elementary School Students</th>
<th>Middle School Students</th>
<th>High School Students</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low (1) to High (5)</td>
<td>15139 Students</td>
<td>11344 Students</td>
<td>13468 Students</td>
</tr>
<tr>
<td>1</td>
<td>592 (4%)</td>
<td>161 (1%)</td>
<td>726 (5%)</td>
</tr>
<tr>
<td>2</td>
<td>3393 (26%)</td>
<td>2639 (23%)</td>
<td>7955 (59%)</td>
</tr>
<tr>
<td>3</td>
<td>5226 (35%)</td>
<td>4904 (43%)</td>
<td>4228 (31%)</td>
</tr>
<tr>
<td>4</td>
<td>5126 (34%)</td>
<td>3147 (28%)</td>
<td>559 (4%)</td>
</tr>
<tr>
<td>5</td>
<td>202 (1%)</td>
<td>493 (4%)</td>
<td>0 (0%)</td>
</tr>
</tbody>
</table>

When comparing the different age groups, high school students (C-17) have significantly lower access than students in middle (C-16) or elementary school (C-15). There are a variety of choices within the methodologies of this project which may explain this difference in access (e.g. the decision to not count programs within public high schools, the use of a universal scale for access by age group). High school students also have more options for transportation to areas further from their homes, and many students have after-school jobs which were not included in this project. Yet, the differences in access between high school students and younger students are still significant. This may be an area of further exploration into the needs of high school students and the options available to them after school.

Overall, the composite method yields an index of access with a more complex reflection of access to after-school programs for students in the Saint Paul Public School system. It is important to note that the weighting of the three variables within this method may yield a significant source of bias, but a more educated weighting would require extensive study. This method provides a good start to examining student access to after-school programs within the city of Saint Paul. Several areas of interest are identified in this method to which further attention should be given.
Middle School Access to Programs by Raster
Saint Paul, Minnesota

Index of Student Access by Raster Method

- 1 (Lowest)
- 2
- 3
- 4
- 5 (Highest)

Block Groups With Under 50 Students
Relevant Programs

0 0.5 1 2 Miles

Macalester College
GEOG364
29 April 2007
Data Source: ESRI
Saint Paul Public Schools; US Census
Summary

The numerous maps created by both methods showed general areas that repeatedly exhibited high or low access. Of course, specific examination of the maps and the situation on the ground is necessary for a more precise and accurate analysis.

General areas of repeated high access:
- West Side
- St. Anthony

General areas of repeated low access:
- Downtown
- Along 35E
- Payne-Phalen
- Battlecreek-Highwood

In addition to these spatial patterns, the maps show that access to after-school programs is markedly lower for high school students, perhaps because they tend to rely on their schools for after-school activities. Additionally, the maps show that athletic programs are the most widespread, and arts programs are generally the least available.
Recommendations for Further Data Collection

We suggest that the Second Shift Initiative create an open-source database or wiki\(^8\) of after-school programs in Saint Paul. Collecting and organizing data on after-school programs in Saint Paul is a complicated and time-consuming task. Asking directors and organizers of after-school programming to take on the task of organizing and updating this information will give the Second Shift Initiative more data and more time to analyze it. Additionally, an open-source database would allow directors and organizers to classify the frequency, cost, capacity, and other variables of their programs. This database could then be used for analysis and turned into a “virtual one-stop”. This virtual one-stop could be used in the future as a resource for parents and students.

Recommendations for Further Investigation

Several areas of interest are apparent across the three sections of this project (see map D-1). These areas have large populations of students in the Saint Paul public schools, large numbers of students on free and reduced lunch, and a large percentage of students of color. In addition, there are few to no after-school programs in these areas of high student density. In both methods of access calculation, these areas of interest have the lowest access ratings.

<table>
<thead>
<tr>
<th>Block Group Number</th>
<th>Total Number of Students</th>
<th>Percent Students of Color</th>
<th>Percent Students with Free or Reduced Lunch</th>
</tr>
</thead>
<tbody>
<tr>
<td>325003</td>
<td>373</td>
<td>91%</td>
<td>83%</td>
</tr>
<tr>
<td>329001</td>
<td>532</td>
<td>98%</td>
<td>95%</td>
</tr>
<tr>
<td>374035</td>
<td>333</td>
<td>78%</td>
<td>71%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Block Group Number</th>
<th>Elementary School Student Access</th>
<th>Middle School Student Access</th>
<th>High School Student Access</th>
</tr>
</thead>
<tbody>
<tr>
<td>325003</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>329001</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>374035</td>
<td>1</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

Our unfamiliarity with the Saint Paul area served as both a strength and weakness of our analysis. While this status fostered objectivity in our data collection and analysis, it has simultaneously limited our ability to make extensive policy recommendations. Further investigation into the demand for and availability of after-school programming in these areas should be done through direct communication and interviews with community

\(^8\) See footnote 1 (After-School Program section conclusion)
members involved in all stages of this process. If future investigation confirms our own findings that these areas significantly lack access to after-school programming, then these areas should receive further attention from policy makers to increase access.

Policy recommendations may include circulator buses which provide transportation to clusters of after-school programming, establishment of new after-school programs within these areas, or expansion of after-school programs in nearby areas.
Block Groups with Consistently Low Access
Saint Paul, Minnesota

A: Block Group 325003
B: Block Group 329001
C: Block Group 374035

- After-School Program Locations

Macalester College
GEOG364
30 April, 2007
Data Source: ESRI, Saint Paul
PublicSchools, US Census
REFERENCES

   http://www.census.gov/geo/www/tiger/glossry2.pdf


   Accessed May 1, 2007


TECHNICAL APPENDIX

TECHNICAL APPENDIX A: Public School Students

I. Cleaning Data
II. Geocoding
III. Joining Data
IV. Map Analysis and Creation
      A. List of Maps

I. CLEANING DATA

The first step of data manipulation was the identification and removal of duplicate records. Using Microsoft Excel software, all duplicate records were identified. Using the Data Filter function, a record of only unique addresses was maintained:

1. “Data”  “Filter”  “Advanced Filter”  Select “Filter in place”  Select “Unique records only”  “OK”  Excel selects all the duplicate records.
3. In spreadsheet with complete records: “Data”  “Filter”  “Show all” and record number of all records.

After following the above procedure, only unique records were maintained in the database, duplicate records were removed and the total duplicate records were counted.

The next step was to remove all the addresses of students not located in Saint Paul. These were identified in Excel after sorting the database according to the “city” column. Files containing any other cities except “St. Paul” were omitted. The database was examined and other mistakes were corrected so that:

1. Spelling of “St. Paul” (e.g. St. Pual, Saitn Paul etc)
   a. This was interactively corrected so that all the records would read “St. Paul”
2. 9-digit zip codes which would not be recognized by ArcMap®
   a. These were changed to 5-digit zip codes, recognizable by ArcMap® (e.g. 55104-2132  55104).
3. All cells containing “NULL” as information
   a. These were replaced with a SPACE ( ) using the “Replace” function in Excel.
   b. “Edit”  “Replace”  Select “Replace” tab  “Find what:” NULL  “Replace with”: SPACE ( )  “OK”
Because the addresses in the original database were divided into several fields such as the “Street name”, “House number” and “Street dir”, the next step in the data manipulation was to merge all the fields into one column containing the full address, otherwise ArcMap® would not be able to identify the address. Therefore the “Concatenate” function in Excel was used to join several text strings into one string. The following procedure was carried out:

1. Before the “City” column, add a column: Highlight “City” column → “Right Click” → “Insert” → This automatically adds a new column. Name the column “Address”.
2. Using the same steps another column was added after “Street name”. Type a SPACE ( ) in the first cell and name the field “Space”.
3. Type the following formula into the first cell of the “Address” field: 
   
   \[=\text{Concatenate} \left( \text{Corresponding cell for “Street Number”}, \text{Corresponding cell for “Space” with the “$” before cell letter and cell number e.g. $C$4}, \text{Corresponding cell for “Street Name”}, \text{Corresponding cell for “Space”}, \text{Corresponding cell for “Street Type”} \right) \]
   
   a. The formula in the cell looked like this:
   
   \[=\text{Concatenate}(A1,$D$1,B1,$D$1,C1)\]
   b. * Using the $ symbol allows the use of the same cell throughout the subsequent “fill down”.
4. Select and drag the first cell to “fill down” “Address” field to the end of the database, so that Excel will merge all the addresses of the spreadsheet.
5. “Edit” → “Save”

After performing all the major changes required to perform effectively in ArcMap®, the database was saved as an Excel spreadsheet. The spreadsheet was imported into Microsoft Access using the following procedure:

1. “File” → “New” → “Blank Database” → Name the file appropriately → “Save” in workspace → “Create”. This creates a new empty database.
2. “File” → “Get external data” → “Import” → Select file type “Excel” → Navigate to your personal space and find the student addresses database. → “Import”
3. Select the radio button “First Row Contains Column Headings” → “Next” → The default was left → “Finish”
4. The database is now imported in Access and the document saved.

The Access database was saved and used as it is easier to manipulate in ArcMap® and there is much less potential for corruption for the file.
II. GEOCODING

The next step was to import the file into ArcMap® and load the addresses onto the map of Saint Paul. The process of placing points on a map from a given address is called “geocoding”. The following geocoding procedure was used in the ArcMap® interface:

1. Open ArcMap® → “Add data” button → Navigate to your personal space and find the saved .dbf file → “Ok” → The table is now added in ArcMap®
2. Right click on the table → Geocode Addresses → Choose an address locator to use → “Add…” → Look in: “Address locators” → Select a suitable address locator system → “OK” → Select output shapefile or feature class → Navigate your personal space and select folder to save the new file → Name the file → Save → “OK”
3. ArcMap® will geocode all the addresses that could identify and present matching statistics → Record the statistics.
4. Click “Match interactively” → Select the address best suited or correct the ones that did not geocode → Close → Save your document.

ArcMap® placed points on the map with all the addresses that it could recognize. Several addresses that could not be identified by ArcMap® were interactively matched by the user and any error in the address data was corrected accordingly. Typical error in the addresses included misspelled addresses and location, wrong zip-code, wrong street direction and addresses that contained P.O. Boxes.

To ensure that all the data used is in the city of Saint Paul boundaries, a spatial intersect was performed so that the output included only the addresses in the city of Saint Paul. After the geocoding process was completed descriptive analysis of the results was conducted. The summary of the process is indicated on the following table:

Table 1: The table indicates the cumulative results from the geocoding process, including the omitted, unmatched and corrected addresses.

<table>
<thead>
<tr>
<th></th>
<th>Total</th>
<th>Percent of Original Records</th>
</tr>
</thead>
<tbody>
<tr>
<td>Omitted Addresses</td>
<td>2996</td>
<td>6.92 %</td>
</tr>
<tr>
<td>Addresses Corrected (added to Total Geocoded)</td>
<td>591</td>
<td>1.36 %</td>
</tr>
<tr>
<td>Addresses Unmatched</td>
<td>269</td>
<td>0.62 %</td>
</tr>
<tr>
<td>Total Geocoded</td>
<td>40054</td>
<td>92.46 %</td>
</tr>
</tbody>
</table>
Table 2: The table indicates the error after geocoding and the reasons for the omitted addresses. These include “Duplicate” and “Non St. Paul” addresses

<table>
<thead>
<tr>
<th></th>
<th>Total</th>
<th>Percentage out of Geocoded</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Geocoded</td>
<td>40054</td>
<td>100 %</td>
</tr>
<tr>
<td>Unmatched (represents error)</td>
<td>269</td>
<td>0.67 %</td>
</tr>
<tr>
<td>New Address</td>
<td>164</td>
<td>0.41%</td>
</tr>
<tr>
<td>PO Box</td>
<td>28</td>
<td>0.07%</td>
</tr>
<tr>
<td>Unknown</td>
<td>77</td>
<td>0.19%</td>
</tr>
<tr>
<td>Omitted Addresses</td>
<td>2996</td>
<td>7.48%</td>
</tr>
<tr>
<td>Duplicate</td>
<td>1116</td>
<td>2.79%</td>
</tr>
<tr>
<td>Non St. Paul</td>
<td>1880</td>
<td>4.69%</td>
</tr>
</tbody>
</table>

Once the addresses were geocoded and mapped in the City of Saint Paul, the next step was to add the personal information of the students. This included information such as the age, sex, test scores, language, race and eligibility of free lunch for each of the students. These data were provided by the Saint Paul Public School District. The information was provided as an SPPS file and then converted to a Microsoft Excel spreadsheet. The attributes of the spreadsheet include data on the distinction between groups of “white” and “non-white”, the students that were eligible for a free lunch as a means of an indication of their family economic status and the first language of the students, where the classes of “English”, “Hmong” “Spanish” and “Other” were identified. “Other” is a collective class for the students that do not speak English, Hmong or Spanish. Initial manipulation of this data in Excel was required. All cells containing “NULL” as information were replaced with a SPACE ( ) using the “Replace” function in Excel.

“Edit” → “Replace” → Select “Replace” tab → “Find what:” NULL → “Replace with”: SPACE ( ) → “OK”

Because some of the data was provided in the form of numerical values (like language: 1 – English, 2 – Hmong, 3 – Spanish, 4 – Other), additional columns were necessary to our data to separate the different languages, distinction between “white” and “non-white” and “eligible” and “non-eligible” for free lunch. Columns were added next to the according attributes, and the “IF” function in Excel was used to discriminate between data:

2. After the “Language” column, add a column: Highlight “Language” column → “Right Click” → “Insert” → Automatically adds a new column. Name the column “English”

3. Since “English” was coded as “1” in the Language column, we want only the values that were equal to “1” to be included in the new “English” column. The following formula was used in the first cell: [=IF, {Corresponding cell for “Language”} = 1, 1 (for true), 0 (for false)]. An example would be [=IF, E2=1,1,0]

4. The first cell was “filled down” to the end of the spreadsheet.
This resulted in a column where all the records of the students with English as their language had a value of “1” while the rest had a value of “0”. The same procedure was repeated for the rest of the languages, the “white” – “non-white” column and for the eligibility for free lunch.

III. JOINING DATA

The next step was to import the spreadsheet into Microsoft Access® using the same procedure as described above. The file was also manipulated in Access® in order to make sure that all the appropriate attributes were saved as numerical values. If they were saved as text, they were converted to numerical values, recognizable by ArcMap®. The file was saved as a Microsoft Access file to avoid corruption while being used in ArcMap®.

The student data file was added to the map with the geocoded addresses. The point layer of all the addresses and the table were joint using the fields “code_stu” and “student” as their common fields. The following procedure was used:

Right click on the point layer → Joins and Relays → Join → In “What do you want to join to this layer?” → Join table to point layer → Select common fields to join “code_stu” and “student” → Select folder to be saved → “OK”.

The resulting point layer included the attributes of the table, so each point on the map would be represented by students with their personal data. The file was exported as a separate shapefile and saved:

Right click on the point layer → Export layer → Navigate personal space and select folder to save the shapefile → Name the shapefile → “OK”.

The shapefile was used to calculate aggregated data for the block groups of the city of Saint Paul. This was necessary in order to maintain the privacy of the individual students, and in order to be able to observe trends in the data within the block groups of the city of Saint Paul. In order to aggregate the data, the point layer with all the attributes of the students was joined to the polygon layer of the Saint Paul block groups. The procedure calculated both the average and the sum of each of the attributes of the number of students located within each of the 291 block groups:

Right click on the polygon layer of the Saint Paul block groups → Joins and Relays → Joins → In “What do you want to join to this layer?” → Select “Join data from another layer based on spatial location” → In “Choose point layer” select the address point layer to join → Choose the radio button “Each polygon will be given a summary of…” → Select the radio buttons “Average” and “Sum” → In “Save as a new output” → Navigate your personal space and select location to save the new shapefile → Name the file
appropriately and “save” \(\Rightarrow\) “OK” \(\Rightarrow\) ArcMap will perform the spatial join of the two files.

The output of this join is a shapefile that contains aggregated student data for each block group and contains new attributes such as the “Sum_English” or the “Average_read” which where used to map the spatial variation of the student information within the city of Saint Paul.

IV. MAP ANALYSIS AND CREATION

Using the data in the final shapefile, the following maps were produced both in color and in black and white color schemes:

A. List Of Maps

1. Non – white students, Saint Paul Public Schools, Minnesota (A-1)
2. Students Qualifying for Subsidized Lunches, Saint Paul Public Schools, Minnesota (A-2)
3. English speaking students, Saint Paul Public Schools, Minnesota (A-3)
4. Hmong speaking students, Saint Paul Public Schools, Minnesota (A-4)
5. Spanish speaking students, Saint Paul Public Schools, Minnesota (A-5)
6. Students speaking other languages, Saint Paul Public Schools, Minnesota (A-6)
7. Basic Battery scores, Saint Paul Public Schools, Minnesota (A-7)
8. Basic Battery scores by category, Saint Paul Public Schools, Minnesota (A-8)
9. Math scores, Saint Paul Public Schools, Minnesota (A-9)
10. Math scores by category, Saint Paul Public Schools, Minnesota (A-10)
11. Reading scores, Saint Paul Public Schools, Minnesota (A-11)
12. Reading scores by category, Saint Paul Public Schools, Minnesota (A-12)
I. DATA COLLECTION

A. Original List of Collected Information
   - Program Name
   - Agency Name
   - Contact Name, e-mail, phone number
   - Address
   - If the activity was classified as art, academics, athletics or other
   - What grades the program served
   - How often and when the program met
   - If kids could just drop in
   - Cost and scholarship opportunities
   - If the program targeted a specific population
   - If the program was coed, girls only or boys only
   - The number of kids who attended and the maximum capacity
   - If transportation was provided
   - If the staff spoke Hmong, Somali, Spanish or another language
### Final List of Collected Information

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Agency Name</td>
<td>The organization who runs the program.</td>
</tr>
<tr>
<td>Address</td>
<td>The address where the program takes place.</td>
</tr>
<tr>
<td>Activity: Art</td>
<td>Activities with an emphasis in the fine arts. Examples include painting classes, music and dance.</td>
</tr>
<tr>
<td>Activity: Academic</td>
<td>Activities with an academic emphasis. Examples include tutoring and language classes.</td>
</tr>
<tr>
<td>Activity: Athletics</td>
<td>Activities with a focus on organized movement or exercise. Examples include sports teams, yoga and dance.</td>
</tr>
<tr>
<td>Activity: Other</td>
<td>Activities that are not encompassed in the above categories. Examples include chess, babysitting classes and Red Cross first aid classes.</td>
</tr>
<tr>
<td>Grades the program served</td>
<td>Grades were divided into the following categories: K-1, 2-4, 5-6, 7-8, 9-10, and 11-12. For example if a program was for only second graders the 2-4 category was marked.</td>
</tr>
<tr>
<td>How often the program met</td>
<td>This category was divided into three subcategories: 1) programs met on a monthly basis 2) programs met on a weekly basis 3) programs met more than once a week. The most frequent meeting basis was ascribed to each location.</td>
</tr>
<tr>
<td>Cost</td>
<td>Because of the payment periods (some programs charged monthly, some by quarters, others by class) the cost category was divided into three subcategories: 1) locations that only offer free programs 2) locations that only offer programs with a cost 3) locations that offer both free programs and those with a cost.</td>
</tr>
<tr>
<td>Maximum capacity of a program</td>
<td>Estimates of the maximum possibly capacity of students at any given day, any given time as reported to data collectors by agency contacts.</td>
</tr>
</tbody>
</table>
II. DATABASE MANAGEMENT

A. Summary Table

When maintaining the master database of after-school programs, the group had to define each variable-column in Microsoft Access.

Unique_ID: The unique IDs were created using an 8 character code. The first four letters of the code are taken from the first letters of each word in the agency name (up to four words). If there are less than four words, the second and third letter of the last word would be used. Then there are two numbers that are the first two numbers of the street address number. Finally there are two letters that are the first two letters of the street name (not including cardinal directions or “Saint”). For numbered streets (4th St, 8th St, etc.) the numbers are spelled out (Fourth, Eighth, etc) and this is used as the street name. For example: 

**Big Brothers, Big Sisters at 1140 E 3rd St (World Cultures Magnet School) = BBBS11TH**

Skyway YMCA at 194 E 6th St = YMCA19SI

Program_Name: The name of the program, this may differ from the agency name.

Agency_Name: The organization that runs the program, which is sometimes the same as the program.

Address_1: Site where the program happens.

Address_2: Which may be a mailing address or agency address. Any address relevant to the program, which isn’t included in the Address 1.

Contact_Name: When available, the person from whom we obtained the data.

City: St. Paul

Zip: U.S. five digit postal code.

Phone: Phone number

Activity_Art: Programs that contained an art component received a ‘Y’ in this column, all other programs received an ‘N.’

Activity_Athletic: Programs that contained an athletic component received a ‘Y’ in this column, all other programs received an ‘N.’

Activity_Academic: Programs that contained an academic component received a ‘Y’ in this column, all other programs received an ‘N.’

Activity_Other: Programs that contained a component not included in the above categories received a ‘Y’ in this column, all other programs received an ‘N.’

*Programs could be included in more than one activity category.*
K_1: (Ages 5-6) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

2.4: (Ages 7-9) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

5.6: (Ages 10-11) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

7.8: (Ages 12-13) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

9.10: (Ages 14-16) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

11.12: (Ages 17-19) Programs that served students within this age group received a ‘Y’ programs all other programs received a ‘N.’

*Programs could be included in more than one age category.

Frequency: Programs met on a monthly basis were given a 1. Programs met on a weekly basis were given a 2. Programs met more than once a week were given a 3. The most frequent meeting basis was ascribed to each location.

School_Year: Programs that were offered during the school year were given a ‘Y,’ all other programs received an ‘N.’

Summer: Programs that were offered during the summer received a ‘Y,’ all other programs received an ‘N.’

Cost: The range of costs for programs offered at this location was entered into this field.

Scholarship: If a program or agency offered financial assistance to students entering the program received a ‘Y’ in this field. All other programs, and programs without a cost received an ‘N.’

Max_Kids: The maximum capacity of the program or location was entered in this field, usually a rough estimate by a program or agency staff member.

Description: A list of programs at that location, which we have data for.

Other_Info: Other relevant information.
II. MAP ANALYSIS AND CREATION

A. Map Sources
Maps were created using ArcMap 9.1. Student data was provided by Saint Paul Public Schools. Block group shapefiles were provided by the United States Census. Shapefiles of highways and bodies of water were provided by ESRI. Shapefiles of neighborhoods and county boundaries were provided by the Metropolitan Council. Information about after-school programs was compiled by students in GEOG364 at Macalester College during the spring of 2007. After-school program locations were geocoded using a road file with topology from the Lawernce group (December 2006).

B. Nearest Neighbor Distance Analysis:
In order to tell how the after-school programs were distributed across Saint Paul we used nearest neighbor distance. This analysis allowed us to see if the programs were clustered, randomly distributed or evenly distributed across the city. In order to complete the statistical analysis we used ArcGIS.

Statistics

1. Academic, Art, Athletic and Other Program Maps

   Academic Programs
   
   Observed Mean Distance = 0.81
   Expected Mean Distance = 0.81
   Significance level 0.01
   Critical value -2.58
   Z score = -2.8 standard deviations

   The spatial pattern is clustered. There is less than 1% likelihood that this dispersed pattern could be the result of random chance.

   Art Programs

   Observed Mean Distance = 0.93
   Expected Mean Distance = 0.93
   Z score = -0.8 standard deviations

   The spatial pattern is random. It is neither clustered nor dispersed.

   Athletic Programs

   Observed Mean Distance = 0.82
   Expected Mean Distance = 0.82
   Significance level 0.01
   Critical value -2.58
   Z score = -2.8 standard deviations

   The spatial pattern is clustered. There is less than 1% likelihood that this dispersed pattern could be the result of random chance.
Other Programs

Observed Mean Distance = 0.81
Expected Mean Distance = 0.81
Significance level 0.01
Critical value -2.58
Z score = -2.7 standard deviations

The spatial pattern is clustered. There is less than 1% likelihood that this dispersed pattern could be the result of random chance.

2. Free and Fee-Based Program Maps
All sites providing at least one free program:

Observed Mean Distance = 0.81
Expected Mean Distance = 0.81
Significance level: less than .01
Critical value -2.58
Z score = -2.8 standard deviations

The spatial pattern is clustered. There is less than 1% likelihood that this dispersed pattern could be the result of random chance.

All sites providing at least one fee-based program:

Observed Mean Distance = 0.86
Expected Mean Distance = 0.86
Significance level: more than .10
Z score = -1.7 standard deviations

The spatial pattern is random. It is neither clustered nor dispersed.

C. Age Group Index
To map the distribution of program locations by age group, a column was added to the database and assigned each program a number. The numbers assigned are outlined in the index below:

<table>
<thead>
<tr>
<th>Index Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>K_4 + 5_8 + 9_12</td>
<td>ALL</td>
</tr>
<tr>
<td>K_4</td>
<td>Elementary Only</td>
</tr>
<tr>
<td>5_8</td>
<td>Middle School Only</td>
</tr>
<tr>
<td>9_12</td>
<td>High School Only</td>
</tr>
<tr>
<td>K_4 + 5_8</td>
<td>Elementary and Middle School</td>
</tr>
<tr>
<td>K_4 + 9_12</td>
<td>No Middle School</td>
</tr>
<tr>
<td>5_8 + 9_12</td>
<td>Middle and High School</td>
</tr>
</tbody>
</table>
There are 3 age groups: K-4 (elementary), 5-8 (middle school) and 9-12 (high school). A program needed a ‘Y’ in only one age category (K-1, 2-4, 5-6, 7-8, 9-10, 11-12) to qualify as having programs serving the age group. Example: If a program received ‘Y’s for the age categories K-1, 7-8 and 11-12, this program would have programs in each age group K-4, 5-8 and 9-12 and therefore would receive a ‘1’ from the index, indicating this location had programs available for all age groups.

For example, the Eastside YMCA received a ‘1’ because it contained a ‘Y’ in each age group (K-4, 5-8, 9-12).

D. Choropleth Maps
Maps showing block groups’ student population, percent students of color, and percent students receiving free lunch, utilize natural breaks, a data classification method that divides the data into categories along natural data clusters. This avoids artificial cutoffs in the data that is present with other classification systems.

E. After-School Programs by Capacity
In order to analyze the data given in the maps, a nearest neighbor analysis was conducted, resulting a very significant clustered pattern. In addition, the ten percent of programs with the highest rates of students of color and students receiving free lunch were selected. A spatial join was run between this layer and the after-school point layer. The point was to see what percentage of after-school programs were present in the areas that had the highest percentage of these two characteristics. The number of programs in these areas was divided by the number of programs in all of Saint Paul. The ten percent of block groups with the highest rates of free lunch had 15 percent of after-school programs in Saint Paul. The ten percent of block groups with the highest rates of students of color had 16 percent of the after-school programs.
TECHNICAL APPENDIX C: Access to After-School Programs

I. Overview
II. Creation of Layers
   A. Data Sources
   B. Student Layers
   C. Program Layers
III. Student Access to Spaces (SATS) Method
   A. Explanation
   B. Step-by-Step Methodology
   C. Classifying the Data
IV. Composite Method
   A. Explanation of Model
   B. Step-by-Step Methodology

I. OVERVIEW

Access was defined as the ability for a student to find an after-school program for their age group within walking distance of their residence. We defined walking distance as one-half mile from the home address listed in the Saint Paul Public School database. Student data was analyzed at the individual level and aggregated to the Census block group level for presentation because of data confidentiality.

Two methods were chosen to assess access. One method—the student access to spaces method (SATS)—counted the number of after-school program spaces within a half-mile radius for each student, based on the estimated maximum capacity of programs. An average number of spaces within walking distance was then determined for each block group. Using this method, we created thirteen maps, looking at both specific age groups and specific program types.

While the SATS method directly considered the capacity of nearby programs, it did not account for the number of students in a block group or the number of different programs. A second method—the composite method—was chosen to incorporate these two factors in addition to program space. We made four maps using this method, assessing access to programs overall and for three different age groups.

All maps and analysis were created using ESRI’s ArcGIS ArcMap 9.1®. Data used in our analysis included program data and student data as explained in the preceding sections, and a block group layer from the US Census Bureau.

---

9 A distance of one half-mile was chosen because this is the distance that the Saint Paul Public School system expects students to be able to walk to bus routes.
II. CREATION OF LAYERS

A. Data sources
We were given layers that included all of the Saint Paul Public School students and all after-school programs. The first step was to select certain groups from these master-datasets to create new layers so we could make new layers of subsets of students and programs.

B. Student Layers
We created three new layers of students: elementary schoolers, middle schoolers, and high schoolers. We defined elementary schoolers as K-4 students, not including early childhood special education students (as these are 0-4 year-olds), or attendees of morning and afternoon four-year-old programs. Middle schoolers are defined as 5th through 8th graders, and students in 9th grade and above are defined as high schoolers. To create these layers, we selected the relevant students by attributes, and then exported the selections as layers.

C. Program Layers
Twelve layers of program locations were created. Three of these were layers of programs by age group: program locations serving elementary students, program locations serving middle schoolers, and program locations serving high schoolers. Nine were layers that were specific to both the three age groups and the three program types—programs that offer arts activities, programs that offer academic activities, and programs that offer athletic activities. An example of this type of layer would be, “programs locations that serve high schoolers and offer athletic activities.”

III. STUDENT ACCESS TO SPACES (SATS) METHOD

A. Explanation
In this method, we used GIS to calculate the number of after-school program spaces within walking distance of each student, based on the estimated maximum capacity of programs, and then determined the average number of spaces for students in each block group. The result is a unique value for each block group representing the average number of program spaces within walking distance of that block group’s student population. Block groups with low values are considered to have lower access than block groups with higher values. The methodology that follows could work with whatever combination of student layer and program layer that would make sense.

B. Step-by-Step Methodology
1. Buffer ½ mile (see above for justification) around all of the points in the student layer. This gives a new polygon layer showing the walking ranges of every student.

2. Spatially join the program point layer to the student-buffer polygon layer, making sure to check off the “sum” box in the join window before
clicking OK. Each polygon in the buffer layer now has an attribute listing the total number of spaces within its bounds (Sum.MAX_KIDS).

3. Join the student points to the buffer polygons by the student ID attribute. Now each student point will have an attribute listing the total number of program spaces (y) within a ½ mile radius.

4. This attribute is only joined to the student point dataset virtually, and is not actually part of the student data. In order to integrate the virtually joined data into the original student data, “solidifying” the join, one must export the data set and save as a new layer which will be added to the ArcMap file.

5. Spatially join the block group layer to this newly made student layer, making sure to check off the “average” box in the join window. Each block group will now have an attribute showing the average number of program spaces within ½ mile of each student within its bounds (Average.Sum.MAX_KIDS).

6. Change the symbology of the block group layer so that block groups are displayed differently depending on the values of this attribute.

C. Classifying the Data
Initially, we developed our five classes of access based on natural breaks of the average of the sum of program spaces, as explained above. To make certain that similar maps were easily comparable—such as elementary access to arts, to athletics, and to academics—we created four standard classification systems by taking the mean of the upper bound of the bottom four classes for each of the relevant maps and making those means the new upper bounds. The highest class for each map is boundless.

III. RASTER METHOD FOR ACCESS GROUP

A. Explanation of Model
For this method, we are interested in combining three variables to determine student access to after-school programs. The criteria and weights we use to determine access are as follows:

1. The average **number of programs** within a ½ mile of each student in each block group (40 percent influence)
   
   _Reasoning:_ The number of programs each student has access to is the most important factor, assuming that programs will not be filled to capacity and in offering students a range of types of programs.

2. The average **number of program spaces** within a ½ mile of each student in a block group (30 percent influence)
   
   _Reasoning:_ This criteria takes into account the supply of programs. Some programs have the capacity to absorb 300
students, some only 20 children. Thus, the greater the number of program spaces, the greater the overall access.

3. The **number of students** per block group (30 percent influence).

   **Reasoning:** This speaks to the demand side for programs. The greater the number of students in an area, the greater the demand for programs.

**B. Step-by-Step Methodology**

1. Determine the number of programs each student has access to within a ½ mile.

   a. Create a ½ mile buffer around every student in Saint Paul.

   b. Spatially join the programs layer (all_merge_final_merge) to the buffers and check off the box that says “sum.” This adds a new field to the attribute table that gives us the number of programs inside each student’s buffer. This field will be the “count” field in the attribute table. Title this new layer stu_prgm_buffer_sum.

   c. Join the stu_prgm_buffer_sum to the student points (Masterfile_fo_access_group) on the “ID” field.

   d. Export the layer to make the join permanent. Title the layer: stud_prgm_count

   e. Join the new student file, with the program count (stud_prgm_count), to the block group layer. Be sure to check off the “Average” box. This will give you the average number of programs each student has access to. This is most likely displayed as something like “AVG_Count.” Title this new file Prgm_num.

   f. Go to properties → symbology → graduated colors and choose a graduated color ramp. Choose the value as “Avg_count.” Set classification manually for 5 classes. The five classes are:

      - 0.606667
      - 1.350000
      - 1.990000
      - 2.783333
      - [leave the last number alone since the highest bound (reflecting the overall range) will be different across age groups]

2. Create a Raster for the first criterion: number of programs

   Next convert the data to raster.

   a. From the Spatial Analyst menu, click Convert → Features to Raster.
      
      Input: prgm_num
Field: Avg_Count
Title the output: prgm_num

Click OK and convert to raster.

Reclassify this data so that you can compare it with other layers.

Go to Spatial Analyst → Reclassify. In the Reclassify dialog box, set the input raster to Prgm_num. Click the Classify button and manually set the classification breaks. We are using a modified natural breaks classification based on an average natural breaks method across High School, Middle School, and Elementary School. This partially reflects the general distribution of program numbers and allows us to compare the maps across the age groups. However, because the High School Programs are so low, the average is pulled down. In some ways, we are trading the specificity of identifying exact locations of where we should place a new high school program for the ability to compare access across age groups. Set the Classification of the five classes to the following:

0.606667
1.350000
1.990000
2.783333
[leave the last number alone since the highest bound (reflecting the overall range) will be different across age groups]

b. Click OK.
c. For the Output raster, save the file as Prgm_num2 and choose a continuous color ramp.

4. Create Raster for the second criterion: Number of Program Spaces
   a. Buffer (Masterfile_for_Access_group) by 0.5 miles. Name this new layer student_buffer.

   b. Spatially join the programs (programs_final) to the buffers (student_buffer), check off box that says “sum” so that you get the sum of each attribute in (programs_final) for every buffer. This gives us the number of program-spaces within each buffer (field: sum_MAX_KI). Title this new join prgm_spaces.

   c. Join these buffers (prgm_spaces) back to the original point data (Master_file_for_access_group) based on student ID. This gives each student an attribute showing the number of program-spaces within a half-mile.
d. Export the newly joined student point data as a new data layer. This makes the join permanent, and makes sure that all the necessary attributes are part of the student layer. Add this new layer (student_spaces) to map.

e. Spatially join (student_spaces) to block group. Make sure that you have checked off the box that says “Average.” This means the new block group dataset will have new attributes displaying averages of each attribute for all of the students within its boundaries. We’re interested the mean number of program-spaces that students in each block group have within a half-mile of their home. This is most likely displayed as something like “Average_Sum_MA.” Title this new file Avg_Spaces.

f. Go to properties ➔ symbology ➔ graduated colors and choose a graduated color ramp. Set classification manually with 5 classes. This uses a modified (averaged) natural breaks classification scheme based on the values across Elementary, Middle, and High school in the same way that the Program Number layer did. The five classes are:

74.14333
162.92000
273.6967
465.09000

[leave the fifth alone as the highest value will be different across age groups]

Convert the data to Raster.

a. From the Spatial Analyst menu, click Convert ➔ Features to Raster.

Input: Avg_spaces
Field: Avg_Sum_MA
Title the output: blkgrp_space2

Reclassify this data so that you can compare it with other layers.

b. Go to Spatial Analyst ➔ Reclassify. In the Reclassify dialog box, set the input raster to blkgrp_space2. Click the Classify button and change the method to Equal Interval. We are not using natural breaks because we do not want to rank the number of programs each student has access to (a relative measure), but want a more absolute measure of whether there is access or not. Select 5 classes and manually set the classes to the following:

74.14333
162.92000
273.6967
465.09000
[leave the fifth alone as the highest value will be different across age groups]

c. Click OK.

d. For the Output raster, save the file as “spaces” and choose a continuous color ramp.

5. Create Raster for the third criterion: Number of Students

a. Add a field to the Masterfile_for_Access_group titled “stu_num.” Give this field a value of 1.

b. Join the Masterfile_for_Access_group file to the block group file based on spatial location. Click “Sum” so that you make sure you get the total number of students in each block group. Retitle this layer “stu_to_blkgrp.”

c. Go to properties → symbology → graduated colors and choose a graduated color ramp. Set classification to Equal interval with 5 classes. Choose the value as “Sum_stu_num”

d. Flip the color ramp so that fewer numbers of students appears in a darker color. We want to convey in the weighting section that high numbers of students in one area will lead to greater program demand, lowering access for individual students.

Now you will convert the data to Raster.

a. From the Spatial Analyst menu, click Convert → Features to Raster.
   
   Input:  stu_in_blkgrp
   Field:  sum_stu_num
   Title the output:  stu_in_blkgrp

Now, reclassify this data so that you can compare it with other layers.

b. Go to Spatial Analyst → Reclassify. In the Reclassify dialog box, set the input raster to blkgrp_space2. Click the Classify button and change the method to Natural Breaks. Manually re-label the New Values so that the first category has a 5, the next category has a 4, etc. This weights the data so that the higher the number of students, the less access each student has. We are assuming that more students means greater competition and therefore decreased access.

c. Click OK.
d. For the Output raster, save the file as “stu_in_blkgr2” and choose a continuous color ramp.

6. Combine Factors
   a. Combine the three factors using the Weighted Overlay tools. The final score for each cell will be a combination of the three values assigned for each criterion.
   b. ArcToolbox → Spatial Analyst Tools → Overlay toolset. Double-click the Weighted Overlay to open the tool’s dialog box.
   c. In the Weighted Overlay dialog box, click the Add button. Add the number of programs layer (prgm_num2). Click OK. Do the same thing for the spaces (blkgrp_space2) and the students (stu_in_blkgr2) layers.
   d. Assign an influence of 40 to the prgm_nums layer and 30 to the other two layers. Make sure the output raster is saved to your file and title it “Total.”
   e. Change the symbology for the Total Layer. Choose a continuous color scheme. Change the number of default classes to five.

The new layer shows access for different areas of the city. Darker Colors show greater access and lighter colors show less access.